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1.0 Introduction.

Tallies may be connected to the TM1 or to a ESP-1R that is under control of the TM1.

Tallies for the cameras and UMDs etc. may therefore be derived from external inputs from a
Parallel Input/Output (1/0O) interface such as the ESP-1R or may be created within the
TallyMan program.

Tallies from a vision mixer might not used directly but rather as information with TallyMan i.e.
mixer status or it may well be possible to use the Tally In interface provided with several of
the router modules

TallyMan offers Tally Channels (16) to give a tally a second crucial identity in addition to its
actual tally number.

Previous programs / systems have often provided only two tally channels such as red and
green.

In some circumstances, both a red and a green tally might have been linked to a router
source via the tallied router buses — one bus has a red tally as it goes to air and another bus
has a green tally assigned to it as it feeds a VTR for, say, behind-the-goal-action — Iso
recording.

In TallyMan, this idea is extended from two to sixteen channels.

In addition, TallyMan uses System Tallies. These are tallies that may be made from other
tallies, possibly using logical operators such as AND, OR etc. to define how the tally inputs to
the System Tally behave.

In addition, several tallies may be assigned to a System Tally that “belong” to different Tally
Channels. In effect, a System Tally may be considered as a “multicore cable” which can carry
several tallies and tally channels. In this analogy, these tallies are the individual wires of the
multicore cable. A cable with several red cores would have several tallies all belonging to the
“red” family and it may also have different colour cores, which in this analogy, would be tallies
belonging to different channels or families.

An output mask is available whereby channels are selected to determine which input tallies
are actually carried in the System Tally output. This could vary on a show by show basis.

It is important to remember that when mapping tallies to objects, (router destination or
sources) tallies as a rule travel to an earlier source. So, a tally set to a router destination will
tally the selected router source which may then be mapped to an output pin. In addition,
tallies mapped to a router source will be shown on a destination display because that display
is showing the status of that router source.

BUT:

If tallies are mapped to a router source, the destination that selects that tallied source is not
itself tallied and therefore that destination cannot be used to set a tally to an output pin or
used as a control to drive a virtual tally 2 x 1 router across.

In this latter case, if a Direct Tally is set to the destination, the destination is itself tallied and
may then be used as the controlling object.
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2.0 Tally Channels

The TallyMan Program has 16 tally channels.

Any tally in the system must be labelled as belonging to one of these channels. This is
comparable to that found in other systems (e.g. Winsoft); some tallies might be Red with
some uniquely specified as Green for Iso-recording.

In TallyMan this is equivalent to Red tallies being labelled as Program (a default name which
may be user changed) and Green which is equivalent to the label Iso 1. This is important so
that groups or Channels of a tally type may subsequently be mapped to UMD LEDs or to
physical output pins, perhaps via a router destination and hence source.

These individual channels may need to be extracted to unique physical pins for external
triggering of tally lights on cameras, for example.

It will be seen that each dialog box for routers and UMDs has all the configuring information
for that item in that box.

2.1 Naming the Tally Channels.

| M TallyMan - Offline.tms g@@l

File Edit Tools Yew Comms Help
System Properties
MName:  |Simple Spstem Apply
Platform: | %/indows PC -
Spstem Interfaces Firmware
Drefault System Interface * System
Y1.00
Q Interface: | Name Tally Channels
W1.00
System T4l
Add Mew Component | MName tally channels |
Delete Campanent ! M
Ready —=E | OFFLINE UM
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Click on Name Tally Channels. Colours may also be assigned but note that only a Tally Out
Lamp and the Tally Mimic will show these colours.

This screen will now be shown.

Edit Tally Channels

Channel MNarme Tally Colaur The taIIy channels may

be re-named in these

1. |Frogram B — = off dialog boxes. Key in
the new text.

2 |Green . 10: |[ls0 9 aff

3 lo2 off 11: [lso10 off

4 lso3 off 12 [lsa 11 off

5 lod off 13 [s012 off

g laos off 14: [ls013 off

7 lzog off 15 [lsa14 off

g lao7? off 16 [ls018 off

Cancel

3.0 Tally Inputs — Parallel Interface

A TM1 or TM2 selected platform will set a parallel interface as standard with the Logic Level
set as the Tally Input type and Open Collector set as the Tally output type.

In general, Tally Outputs will match the Tally Input type selected.

B TallyMan - Offline CEX
File Edit Tools Wiew Comms Help
- @ Mew Syskem .
Tally /0 P 1
ST System Tally = PN
= Parallel
h,[l Tally In Mame: |F'ara||e| Apply
4% Tally out
+ £ Tally Inputs Tally Outputs
+ ; Display Parts
Hardware: |Logic Level - Hardware: |Open Collectar =
Humber, |32 Mumber: |32
AszignEnable | [ |nvert Enable
JReady =#=E | OFFLINE UM

Note: Additional parallel interfaces are available via the ESP-1/R.
Other types for input for the Parallel Interface.

Tallies from other sources are available — e.g. tallies from other networked TallyMan systems
or from, say, an Omnibus engine as serially provided GPls

Please see Appendix 1 for Omnibus details.
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Set the number of tally ins and outs that you need by changing the numbers in the Number

box and then press Configure 1/O.

For a TM1 keep the total tally numbers to 64 and for the TM2 keep the tally numbers to a total

of 128.

The units are sent out from the factory configured for either 32 in / 32 out (TM1) or 64 in / 64

out (TM2)

Fora TM2

M TallyMan, - Untitled

File Edit

Tools  Wiew  Comms

Help

= @ Mew Syskern
:

; Display Parts

Ready

Tally 1/0 Properties

Marne: |F'ala||e|

Tally Inputs

Hardware: |Logic Level =

Mumber: |54
Agzign Enable | ™ [nvert Enable

Apply

T ally Qutputs

Hardware: | Open Callectar -
Mumber: |64

Clear Forced Outputs |

=l=E | OFFLINE

Changed to 32 in and 96 out.

M TallyMan, - Untitled

File Edit Tools Yiew Comms Help
= @ Mew Syskern . A
Tally /0 P f
+ Parallel 2 IeEEs
; Display Porks
M ane: |F'ala||e| Apply
Tally Inputs T ally Qutputs
Hardware: | Logic Level - Hardware: |Open Collectar =
Mumber: |32 Mumber: |96
Clear Forced Outputs |
Agzign Enable | ™ [nvert Enable
| a3
< >
Ready —&=E| OFFLINE
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TallyMan system tallies in

This is not the same as a System Tally.

It is possible to export tallies from another TallyMan system serially via Ethernet and receive
them locally by setting a Tally I/O module to read the remote TallyMan tallies.

BN TallyMan - Offline =1

File Edit Tools Wiew Comms Help

- Mesw Syskern . -
ﬁ ¥ Tally 1/0 Properties
ST System Tally

- Parallel

t,[l Tally In Marme: |la||ies from another spstem Apply

(El',: Tally CQut
- tallies From another system Tally Inputs T ally Outputs
t,[l Tally In

2 Tally Cut Hardware: | Tallytdan Spstem | = Hardware: | Tallphan Spstem [+
+ ; Display Ports Mumber; |3 Mumber: |8
Spstem ID; |1

Assign Enablg | [ Jrvert Enable

Configure 10 |

Ready ~#E | OFFLINE ML

The TallyMan System ID that is sending the tallies.

The Component Import/Export box must be enabled in the main config screen

M TallyMan - Offline

File Edit Tools View Comms Help

System PropeMdes

+ Parallel

+ tallies From another system lere |New I\Stﬁ &pply
+ ; Display Ports
Platfarm: | J
System |nterfaces Firmware
Add System:
: W1.41
Interface:
| Component Import/E =port | W1.41
Spstem T allies
Add New Camponent | Hame tally channels | 1

LDelete Component ! LConfigure

Ready —#=E| CFFLINE UM
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Component Import/Export Configuration

)
_ Carcel|

v Enable Import/E xpart

System 1D: a

Cancel

Local system ID.

Setting up the Tally Ins.

Select the Tally In list.

M TallyMan - Offline.tms

File Edit Tools WYiew Comms Help
= @ Simple System Index | Tally Input Channel A
- sCi Tally In 1 1: Program
+ Router 1 z Tally Inz 1: Program
= Unit Tallies 3 Tally In 3 1: Program
L[I Tally In 4 Tally In 4 1: Program
% Tally Out 5 Tally In S 1 Program
T ; Display Ports 3 Tally In & 1: Program
7 Tally In 7 1: Program
g Tally Ing 1: Program
9 Tally In9 1: Program
10 Tally In 10 1: Pragram
11 Tally In 11 1: Program L
12 Tally In 12 1: Program
13 Tally In 13 1: Pragram
14 Tally In 14 1: Program
15 Tally In 15 1: Program
16 Tally In 16 1: Program
17 Tally In 17 1: Program
18 Tally In 13 1: Program
< |1 12 Tally In 19 1: Program v
Ready —l=E | OFFLINE MUK

A double-click on a tally input will show this dialog box.

Edit Tally In 1 of Linit Tallies

The drop-down box will
allow the tally to be

/ assigned to a particular
Tally channel.
Tally Channel: |'|: Program j <« | y

I arne: |Eamera'| Red

Repeat Edit
[ Awta lne 7ls0 B

S ls0 8 b’

Canicel

This shows Tally 1 in from a Parallel I/O interface as having the user-defined Name as
Camera 1 Red. It has been set to the Program Tally Channel.
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All incoming tallies may be set to any of the tally channels.

Note: Camera tallies will more normally be derived from information from the Mixer-generated
tallies. Please see the section - 6.5 Tallies and Vision Mixers.

The tallies may be assigned to either the left or the right side UMD LEDs as a Direct Tally or
output to a unique pin on a Parallel I/O interface unit for tallies out to the camera(s).

4.0 Tally Outputs — Parallel Interface

Select the Tally Out list.

M TallyMan - Offline.tms

File Edit Tools Wiew Comms Help
= @ Simple System Index Tally Output Channel A
- SC11 Tally Out 1 1: Program
+ Router 1 2 Tally out 2 1: Program
= Uriit Tallies 3 Tally out 3 1: Program
t,[l Tally In 4 Tally out 4 1: Program
qI_O)I Tally Qut 5 Tally Out 5 1: Program
B8 Display Ports [ Tally Cut & 1: Program
7 Tally Qut 7 1: Program
g Tally out & 1: Program
9 Tally Qut 9 1: Program
10 Tally Qut 10 1: Program
11 Tally ©ut 11 1: Program
12 Tally Qut 12 1: Program
13 Tally Out 13 1: Program
14 Tally out 14 1: Program
15 Tally Qut 15 1: Program
16 Tally Qut 16 1: Program
17 Tally Out 17 1: Program
18 Tally Out 16 1: Program
< > 19 Tally Cut 19 1: Program v
Ready —EE | OFFLINE LI
Double click on an output
Edit Tally Out 1 of Unit Tallies 3]
I &llows user configuration Mame: ||
Mapped Tallies In Active Tally Channel Out
ficld Taly | Delete Selection | W Program I Is08
Tally | Parent Logic | L B lka
[~ lso2 [~ Is10
I E ™ 1011
[~ lsod4 ™ lso12
[~ ls0 B [~ 1013
[~ lso B [~ 1s014
IE ™ ls015
Fepeat Edit
. Cancel
[™ Autolnc
-

Add a tally to the output.
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Add Assigned Tally 3

Tally | Parent | Logic |
b,[l Camera1Red  Unit Tallies

Type: |t,[1 Tally In

Parent: | Unit T allies

Tally: |Eamera 1 Red

Finished Delete Selection

Select the Type, in this case a Tally In.

Select the Parent from the allowable list shown in the drop-down box.
Select the Tally number.

Click on Add

Click on Finished.

Edit Tally Out 1 of Unit Tallies E|
v &llows user configuration Mame: |Eam Tred /P
Mapped Tallies In Active Tally Channel Out .
ficld Taly | Delete Selection | W Program I~ lsod E?}Z:;féllvgia;% ais a
= [~ lsal ™ 19 .
T ally | Parent Logic | se = mask which allows the
L,[I Camera1 R... Unit Tallies E I~ Isa10 checked tally channel
[ Iso3 ™ Iso11 type through to the
[ lsnd I ls12 Output.
[~ ls0 B [~ 1013
[~ lso B [~ 1s014
IE ™ ls015
Fepeat Edit
Cancel
[™ Autolnc
r

This shows that Tally 1 out from the Parallel I/O interface unit has been mapped to Tally 1 in
from the Parallel I/O interface unit. As this input tally was flagged as Program, and Program
in the Active Tally Out box has been checked, a tally is output.

Allow user configuration box has been checked in this example.

For a tally to be output the Active Tally Channel Out box must be checked to match the
input tally attributes.

Repeat Edit will allow-
Auto Increment to the next Tally Output.
Auto copy will copy the input tally to the next Tally Output box.

Several Tally Ins/System Tallies may be mapped to a Tally Out.
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The Active Tally Channel Out mask must be set to allow the Mapped Tallies In to be
output.

These dialog boxes enable User-defined Tally Outs to be made on a show-by-show basis, if
necessary.

If the Allow user configuration box is checked, this screen is available to all users (non
passworded).

Tallies may now be mapped to anything that requires a tally; router buses, sources, UMDs or
Physical o/p pins. The appropriate mapping is carried out in the respective dialog boxes

Note that a tally output may be mapped to a router destination and a check box may be set so
that the O/P will show the status of the selected (tallied) source in the same way that a UMD
would.

Edit Tally Out 1 of Parallel X
- A o Check the Bus
low user configuration
Name: | tally shows
source tally box
Mapped T allies In Active Tally Channel Dut
addTaly | Delete Selection W Program [ Isot
T ally | Logic Channel M ko BE
& Destination 1 [ lsa2 [~ Iz 10
[ lea 3 [ lza 1
[~ lso4 [ ls012
[™ 1305 [ ls013
[ ls0B [ 1s014
< 5 [ Is07 [ lsa15
Repeat Edit
Cancel
[T Auta lnc
-
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Tallies also may be entered via the Tally Pin Patch found via Tools > Tally PinPatch.

¥ Tally PinPatch

De A 2l parallel Tallies =

= : i Zoom Qut
T Tally in - 45 Tally out |~ Tally Cut 3 = D
Parallel Tallies hd 1 2 3 4 [ 6 7 8 q 10 11

(== B B - R - ER Bt

|-
n

|2
|€

Select the Destination first.

A click on the appropriate drop down arrows on any valid tally destination will allow tallies to
be mapped to the correct area.

A click on the drop down arrow in Source will allow any valid tally source to be selected.

A RH mouse click in the Destination column will show all tallies assigned to this channel.

I Allow user configuration Name: |
Mapped Tallies In Active Tally Channel Out
Add Tally | Delete Selection W Program [ |8
T ally | Logic | Channel I et [ lso8
& TallyIn 2 1: Program ™ l1s02 I~ 15010
E ™ 1211
I~ lso 4 ™ lsa12
[ lsob [ ls013
Y [~ 1014
< > [~ Iso 7 [~ Iso15
R b E dit
e Cancel
-
.
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A Shift + RH mouse click in the Source row will show the tally input channel details.

Edit Tally In [g ]
M arne: |EEIITI 3
Tally Channel: |1: Program ﬂ
A b E dit
ETEEI | Cancel
-

When System Tallies are in use:

B Tally PinPatch

De a Main Router et
: ﬂ Zoom Out
"g'E‘ Source < Source 139 I~

4 5 [ 7 8 9 10 11 12

|~

The orange coloured destinations show which destinations already have other tallies mapped
to them.

Tip:

Select the Destination for the tallies first and then the available sources will be visible.
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5.0 System

Tallies.

System Tallies are tallies derived from other tallies or may be permanently ON tallies.

A System Tally may be regarded as a “multicore cable” carrying, possibly, several other
tallies, which may be associated with different Tally Channels (Program, Iso1, Iso2 etc.). The
Active Tally Output Channel can act as either a mask or as a routing tool, depending on how
the Output Logic box is set.

M TallyMan - Offline.tms

File Edt Tools Yiew Comms Help

ST aystem Tally
= 2% 5Cit
+ Router 1
+ Unit Tallizs
+ ; Display Ports

System Properties

Mame:  |Simple Spstem
Plattarm: — |Windows PC -

Suystem Interfaces

[
[
[oonicae |

Add Mew Component |

Defaulk System Interface *

Mame tally channels ‘

Delete Component |

Ready

== | OFFLINE T

Apply

Firrmnweare
Spsten:
W1.00

Interface:
W1.00

System T allies
2
Configure

M TallyMan - Offline.tms
Fle Edit Tools Wew Comms Help

+ Raouter 1
+ Unit Tallizs
+ ; Display Forts

Ready

= @ Simple 5 Index Tally Sutput Channel
ST gE 1 System Tally 1 1: Program
- =5 501 2 System Tally 2 1: Program

=k | OFFLINE HU

A double click on the System Tally out will show this dialog box.

Edit System Tally 1 of Simple System

[~ Allow user configuration

Mapped Talles In

Name: |

X

Active Tally Channel Mask.

% Bitwise [per channel]

addTaly | Dekla Selaction | W Program  lsod
Taly | Parent Tele | I lso1 I Isod
Y ™ 1s010
I~ lso3 I oM
I~ lso 4 I ls012
) [ 1013
I lsoB [ 15014
I lso7 " 1s015
Fiepeal Ecit L) Dulput Logic R

Cancel

This shows that there
are two System Tallies
in this system.

Select the number of
System Tallies that you
might need and press
Configure.

This shows two
System Tallies with
the default flag set
as Program.

™ Autone ™ Permanent On
In " Logical [any channel)
_DK
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5.1 Mapped Tallies In

Add Tally

Input Tallies will associated with one of the Tally Channels. It may be seen that combinations
of tallies may form a System Tally.

Add Assigned Tally

Type: |h,[1 Tally In

Parent: | Unit T allies

Taly:  |Talyln2

Logic

Operatar: Or

[ Irvert

Finizhed

Delete Selection

Tally | Parent | Logic |
b,[l Camera1 Red  Unit Tallies
M TalyIn 2 Urit T allies or

Tally 1 and Tally 2
have been OR'd
together to make a
new System Tally 1

This shows a System Tally created form a Parallel I/O Interface associated with a System
Controller. Parallel Tally In numbers 1 and 2 are OR’d together.

Delete Selection

Edit System Tally 1 of Simple System

[~ Allow user corfiguration

tapped T allies In

[ Auto Inc
-

Add Tally | Delete Selection \
Tally | Farent Logic |
t,[l Camera 1 R... Urit Tallies
M Talyin2 Uit T allies Or
oiEMEEE  uniTalies O
Repeat Edit |9 Output Logic

&+ Bitwize [per channel]

(X

Marne: |

Active Tally Channel Mask

v

(i i R A Bl B

Program
ls01
ls02
ls03
lso 4
ls0 &
lso &
lso 7

2

" Logical [any charnel)

o o i o i i (i

I~ Peimanent On

lzo &

lz0 9

lz0 10
lz0 11
lz012
lz0 13
lz0 14
lz0 15

Cancel

A Name for the
System Tally may be
entered here.

Use Ctrl and click on the tallies as required to delete the tallies from the input box using

Delete Selection.
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5.2 A Permanently ON System Tally.

Edit System Tally 1 of New System 3
This shows a
[ Allow user configuration Mame | System Tally has
been created and is
Statusz tally |° J set to be
Mapped Tallies In Active Tally Channel Mask Permanently ON and
¥ Program L is allocated to the
| | sl I 1309 channel called
Tally | Logic Charinel " lsa2 [~ Isa10 ?rﬂgram/Red
allies.
ST System Tall.. ON I Is03 ™ lso11
[~ lso4 I~ ls012 These names may
[ Iso5 ™ 15013 be changed freely.
Y ™ 15014
oo - 1o The Configurator
< » can allow User
PN access by checking
i the box.
Repeat Edit |9 - \: Cancel
[ Ao Inc i 4
-
r

A use of a permanently ON System Tally.
A permanently ON System Tally may be set, for example to the PGM bus of a vision mixer.

As the mixer cross point selection is known by TallyMan, the mixer sources are therefore
tallied.

If the mixer source is linked to a Tally Out pin, the camera may then be tallied.

Also: A router destination feeding the mixer source will also be tallied (the assignment is
done in TallyMan) which will in turn tally the selected router source.

This router source is tallied as On-Air.
If the router source is linked to a Tally Out pin, the camera may then be tallied.
5.3 Comms Status Tally

A System Tally may be used to indicate the status of the serial comms for any object.

d Edit System Tally 1 of New System X

™ Allows user configuration Name: |
Status tally: |° Mo dzzighment: j
Mapped T allie: ° g Active Tally Channel Mask
Router C1 ¥ Frogam ™ o8 The System
4dd Tally EE:::: E; ™ s 1509 Tally will be
Taly Router C6 ™ lso2 15010 active for no
Router C7 - o 1o 11 link and
E:;'Z' . - leod - o1z inactive for
™ lso B I ls013 good active
EY ™ 1014 comms.
P s I ™ 1015
Repeat E dit |9 Output Logic i e—
B futslis (* Bitwize [per channel) ™ Pemansnt On 4
r " Logical [any channel)
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5.3 The Logic Operator

The operators, OR, AND, XOR and the inversion are allowed.

OR
Tally 1 Tally2 | Output
0 0 0
0 1 1
1 0 1
1 1 1
AND
Tally 1 Tally 2 Output
0 0 0
0 1 0
1 0 0
1 1 1
XOR
Tally 1 Tally 2 Output
0 0 0
0 1 1
1 0 1
1 1 0
Inversion
NOR
Tally 1 Tally2 | Output
0 0 1
0 1 0
1 0 0
1 1 0
NAND
Tally 1 Tally2 | Output
0 0 1
0 1 1
1 0 1
1 1 0
XNOR
Tally 1 Tally2 | Output
0 0 1
0 1 0
1 0 0
1 1 1
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The logic operator adds tallies sequentially as they are added to the list.

E.g. (Tally 1 OR Tally 2) AND Tally 3 - then [(Tally 1 OR Tally 2) AND Tally 3] OR Tally 4.

5.4 Output Logic
Bitwise

In the Bitwise mode the Active Tally Channel Mask boxes act as a mask for the tallies in the
System Tally.

Add Assigned Tally X
Tally | Parent | Logic |
Type: | TalyIn v & Talyin1 Unit T allies
Pt B Talyin2 Uit T allies Or
Tally:  |Talln2 hd
Logic
Operator: Or -
[ Invert
Finished Delete Selection
Edit System Tally 1 of Simple System E| .
Output Logic.
I™ Allow user configuration Name: | Bitwise outputs the
tallies according to
Mapped T allies In Active Tally Channel Mask the |0g ic Operator,
R Dielete Selection ‘ ¥ Program " lso8 !nput Tallies mu.st be
— = s 1 ™ lso0d  lsog in the same Active
S TalyIn Unit Tallies I~ 1502 I~ 15010 Tally Channel.
bfiTalpin2  UritTalies O ™ 103 ™ 1so 11 .
b Talyina Uit Tallies And Logical .
[ lsad [0tz If both tallies are
I lsa5 I 1s013 active, then the
 lsoB ™ lsald channels ticked i_n
a7 ko5 the ou_tput box_wnl
be active (the input
channel associations
Output Lagic J :
Fiepeat Edit |9 o Cancel are ignored)
[™ Ao Ine ¢ Bitwise [per channel] I Pemmnanent On
" Logical hannel
In ogical [any channel] iR

The new System Tally 1 consists of two tallies OR’d, with a third one AND’d, taken from the
Parallel I/O unit tally inputs and remains gated as Program.

When the Bitwise button is selected the Active Tally Channel Mask boxes must be selected
to match the Mapped Tallies In channels.

For example consider the above: Tallies 1 and 2 are associated with the Program channel.
The logic operator is set to AND Tally 3 with Tallies 1 and 2. All tallies must belong to the
same tally channel for the logic operator to work. When the tallies are active an output will be
available that is associated with Program. Program must be checked in the Active Tally
Channel Out mask for the System Tally to be output.

If there were a fourth tally input associated with Iso 4 channel and this is to be OR’d with the
result of [Tallies 1, 2 and 3], for this tally to be output, Iso 4 must be checked too in the Active
Tally Channel Out mask.
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Logical

The logical operator acts in the same way for the input tallies as described for Bitwise but the
important difference is that the output may be mapped to a different Active Tally Channel
Out from any of the input tallies, if desired.

Edit System Tally 1 of Simple System g]
I &llow user configuration Name: | In the Logical mode
) ' the Active Tally
tapped Tallies In Active Tally Channel Out Channel Out boxes
addTaly | Dekte Selection | I Frogram I ko8 route the input tallies
Tally [Faert ez | [ lso1 [ lsa to a selected active
B Taly In1 Urit T allies ™ lso2 I~ 1z 10 channel.
S Talyln2  UnitTalies O W e ™ lsa 1l
. A | (| D .
bITalyind  UnitTalies  And = = The channel Iso 3 is
shown here.
™ 1505 ™ 1013
™ ls0B ™ lsa 14
[~ lso7 ™ ls018
Output Lagic J
Fepeat Edit Ié o Cancel
™ Auto lne " Bitwise [per channel] B Femerer O
" Logical h |
In ogical [any channel]

In this example, the tallies are output in Active Tally Channel Iso3.
Summary

In the Bitwise mode the Active Tally Channel Mask boxes act as a mask for the tallies in
the System Tally (“cable”).

In the Logical mode the Active Tally Channel Out boxes route the input tallies to the
selected active channel.

6.0 Tallies and Vision Mixers

In TallyMan, vision mixers are treated exactly as though they are routers.

Tallies from a mixer are not necessarily used directly. It is possible to tally a mixer destination
to have sources tallied correctly. This is a use for a System Tally set to Permanently ON and

assigned to the PGM bus.

If a tally is set to a mixer / router destination, any source that the destination selects will also
be tallied as long as the mixer outputs router status.

This tallied router / mixer source may be assigned to a UMD and / or to a physical output pin
via a Parallel I/0O unit so that cameras may be tallied.

The tally information coming from the actual mixer into TallyMan is read so that cross point
information is known.

Tip: Several mixer modules do have a Tally In listing. Under these circumstances, as the
Mixer’s internal tally mapping probably needs to be use, it is advisable to map the Tally In
inputs to the Mixer Sources as a first step.
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7.0 Inhibited Tallies

There may be a requirement to inhibit or enable tallies from an object (e.g.) the parallel Sony
Mixer input tallies or from the parallel tally input on the TM1, so that in an emergency, all
tallies from the mixer or parallel inputs are inhibited.

This may be done by using the Assign Enable feature.

M TallyMan - Offline

File Edit Tools Wwiew Comms  Help
] Mew System .
ﬁ i Tally 140 Properties
5T System Tally
;
- B UMD M ame: |Tall}I Apply
Tally Inputs Tally Outputs
Hardware: |Logic Level hd Hardware: |Open Caollectar =
Murnber: |3 Mumber: |3
AgsignEnable | [T [nvert Enable
Connection closed QK ==k | OFFLINE ML

Without any configuration all tallies will normally be enabled in the system.

Press Assign Enable.

Assign Tally rg|

Cancel

Object: [ Tallyln

Parent: | Tally

Led Lef Lo

[bem: |TE|||_'.-' In

L]

This shows that Tally 1 from the Parent called Tally has been assigned as the inhibiting tally.

When Tally In 1 is active, no tallies will be output from the object called Tally In.
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Invert Enable

M TallyMan - Offline

File Edit Tools Wwiew Comms  Help
- ﬁ Mew System .
Tally 140 P b
5T System Tally ¥ fopelies
:
i Tally In Name: |Taly Apply
qi_',i Talky Tk
+ ; L0 Tally Inputs Tally Outputs
Hardware: | Logic Level - Hardware: |Open Collector =
Murnber: |3 Mumber: |3
AgsignEnable | [ [nvert Enable
Ready ~#EE| OFFLINE MUM
Also
Assign Tally § |

Cancel

Object: | Talyin

Parent: | Tally

Led Led Lo

[tem: |Ta||_l,l In

L]

This now means that when Tally In 1 is active, tallies will only then be output from the object
called Tally In.

Notes

e The Tally Mimic under Tools > Tally Mimic will always show the actual incoming tally
status.

e Even if an Object is inhibited, the activating tally for the inhibit function that belongs to
that same object still remains active. Consider the case where there are both serial
tallies (mixer) and parallel tallies (GPIs) in the same Object. The serial tallies are
required to be inhibited but a parallel tally is needed for the inhibit action.
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8.0 Tallies and Routers

If a tally is set to a router destination / bus, any source that the destination selects will also be
tallied.

This tallied router source may be assigned to a UMD or to a physical output pin via a Parallel
I/0 unit such as the ESP-1/R so that cameras may be tallied.

The serial information coming from the actual router into TallyMan is read so that cross point
information is known.

9.0 Tallies and UMDs

UMDs may receive the tallies either directly or via associations with a router destination or
source. Tally Channels need to be associated with the left and right UMD LEDs etc. Please
see the UMD Section for further details.

10.0 The Tally Map

This is accessed via the View Menu and show how the tallies are routed.

M TallyMan - B598 Meridian 131004.tms

File Tools ‘Wiew Help TallyMap
Parent | Tally | Mapped To: | Tally Channel ~
nit Talhes i Fora OUFCeE + ofudio
I3 Uit Tali nost et Fily B source 32 1: Studio 1
Unit Tallies — BI st yez Lurora Sourre 33 1: Studia 1
] Il h & d
unlt Tallies t,l:l SELIfP 3 Aurora ?{‘ Source 34 1: Studio 1
nit Talhes L rora OUrCeE +otudio
I8 Uit Tali nost P4 FAY 2 Source 35 1: Studio 1
B unit Tallies B stzyjp i furora 4F source 36 2: Studio 2
nit Talhes L rora OUrCeE 1 ofudio
] Uit Tl o stzypz FAJE £F source 37 21 Shudio 2
nit Talhes L rora ource +afudio
ISl Uit Tal M ostzips FiFy £ Source 38 2: Studio 2
Unit: Tallies b,l:l SEZ IfP 4 Aurora ?{‘ Source 39 2: studio 2
nit Talhes L. rora OUrCe +otudio
B Uit Tali nostayp Fiy 2f source 40 3: Studio 3
Unit Tallies v SE3IP 2 Aurara Source 41 3: Studio 3
] Il h a2 d
nit Talhes L rora OurCe +ofudio
2] Uit Tl oI st3les FA £F source 42 3 Shudio 3
nit Talhes L rora ource +2afudio
IS Uit Tal Al ostaLpe Fiy 2F source 43 3: Studio 3
unlt Tallies LI:I Sk IfP 14 Aurora ?{‘ Source 47 1: studio 1
nit Talhes L Fora OUFCeE +ofudio
I3 Uit Tali nost e e Fily B source 48 1: Studio 1
Unit Tallies BT Stz 1 14 Lurora Sourre 49 2; Studin 2
g i \ 2 d
B2 it Tallies BT St21P i6 fuirora 4 Source 50 2 Studio 2
nit Talhes L rora OUrCe +otudio
I Uit Tali nJoStayp i4 Fiy 2 source 51 3: Studio 3
Eunit Tallies B St3 1P 16 furora OF source 52 3: Studio 3
nit Talhes L Fora OUFCE +ofudio
] Ui Tl o stiye s FAJE £F source 59 1: Studia 1
nit Talhes L rora ource +afudio
IS Uit Tal M ostzyp 18 Fiy £ Source 59 2: Studio 2
Unit Tallies nI SE3LP 18 Aurara Source 59 3: Studio 3
% I ™ & d
nit Talhes ) rora OUrCe +otudio
B Uit Tali noSt P19 Fiy 2f source 60 1: Studio 1
Unit Tallies rI StZ 1P 19 Aurara Source B0 2: Studio 2
g l n 2 d
W Unit Tallies &1 SE3 1P 19 fuirora 4 source 60 3i Studio 3
nit Talhes L rora ource + afudio
B Uit Tl nJ st P zo Fiy 2F source 61 1: Studio 1
Unit Tallies LI:I St IfP Z0 Aurora ?{‘ Source 61 2! studio 2
nit Talhes L Fora OUFCE +ofudio
I3 Uit Tali n stayp 20 Fiy B source 61 3: Studio 3
Uit Tallies BT st ezt Lurora Sourre 62 1: Studia 1
g Il h ¢ d
Uit Tallies BT stzip2t fuirora O source 62 2 Studio 2
it Tllies DT St3yP 2t Burora L Source &2 3: Studio 3
E
B unit Tallies BT st11ps Burora A source 5 1: Studia 1 e
Ready =5 | OFFLINE UM

Tallies 22 V1.61 on



A double mouse click on a tally line will allow direct editing of the object (e.g. router source or
a Tally Out pin etc.) to which the tallies are mapped.

Edit Source Source 34 @

Hame: |
— a — - Direct Tallies to Source
Qe = o 1 Cam 3
addTaly | Deete Selection |
Mixer Label
" From Mnemonic Tally [ Parent [
S
& Fued nfisnPa Unit Tallies
™ Take 242 characters
Azeignment
" Source Hatrix: ° <Mo Agsignments -
" Destination
r
Fiepeat Edi [ Allow user configuration
Cancel
-
= Category |4l Sources -

11.0 The Tally Mimic

This mimic, seen via Tools > Tally Mimic, will show the status on incoming tallies to the

system and the colour assigned.

B Tally Input Mimic: Parallel

|Ta||_'.-' In & Tally 10 | Parallel

10 12 14 16 18 20 22 24 26 28

Select the appropriate Tally 1./O in the drop down box.
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12.0

Notes on Mixer and Router tallying

Mixer Program Tally to Mixer Source Mapping

Edit Source 1 of Sony Mixer.

MName: |Input 1

Mremanic:

Mixer Button Dizplay Assign

" Fram Mnemanic

[ G Fied -
. o
[ Take 2+2 characters
=
Agsignment

* Source b atris; |° <Mo Azzignment: j
™ Destinatian Saurce: | J

| I~

™ Separate Mnemonic

Fiepeat Edit

[~ Auta Inc
-

™ Allow user configuration

Category: | all Sources d

Direct Tallies to Source

AddTaly |

Delete Selection |

Tally

| Parent |

T Mier Tally 1

Sony Program T ally

X

Cancel

This is the linking in TallyMan. The box below indicates the TallyMan olyject. The video path
is shown only to show that the tallies may be regarded as running in the pposite direction to

the actual video.

Video

Tally

Map the appropriate Program
Tally In to the appropriate Mixer
Source in TallyMan

Tallies
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Mixer Source to Router Destination Mapping

Edit Source 1 of Sony Mixer.

MName: |Input1
remoric. | El Ditect Talles to Souce
Mixer Button Display Assign Add Tally | Delete Selection |
" Fram Mnemanic
[ & Fired r ;E":l e |:a'e”; = |
L ixer Tally oy Pragram T ally
" From Router:
[™ Take 2+2 characters '—_|
Aszsignment
" Source M atrii: | Router j
' Destination Destination: |F|outerDest1 to Mixer 1 j
-
Repeat Edit ™ Allow uzer configuration
C |
[T Auta Inc C ) w
- SF00N. ANl Sources -
-
This is the linking in TallyMan.
It will be seen that any UMDs on the router will be tallied.
Router Mixer
A
A " bt RRRREEE »
< H P H
*oesssrssassserans Il » A .
A
\ A
v

This path is now made in

. TallyMan because TallyMan
Video knows that Mixer Source 1 is
mapped to Router Destination 1
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Mixer Source to Router Source Mapping

This would be used where the router is a monitoring router only and is used for feeding
monitor walls. For example a Camera feeds the input to a router and an input to a Mixer.
Both inputs are effectively common so the Source to Source linking is done in TallyMan. It
will be seen that any UMDs on the router will be tallied.

Edit Source 1 of Sony Mixer.

MName: |Input 1

Mnemonic:

Mixer Button Display Assign

™ Separate Mnemonic

" Fram Mnemanic

-
(* Fixed
" From Router:
[™ Take 2+2 characters
Aszsignment
* Source M atri: | Fouter j
™ Destination Souroe: |Eam1 j

Repeat Edit I~ Allow user configuration
[T Auta Inc .
- Category: | all Sources h

X

Direct Tallies to Source

AddTaly | Delete Selection |

| Parent |
Sony Program T ally

Tally
T Mier Tally 1

Cancel
[ ok |

0K

This is the linking in TallyMan.

Router

Video

This path is now made in
TallyMan because TallyMan
knows that Mixer Source 1 is
mapped to Router Source 1

Tallies
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Now map the Tally Out pin to the Router Source for the Camera CCUs

Add Assigned Tally 3]
Tally | Parent | Logic | Ct
Type: Q’E‘ Source & ‘?{‘ Cam 1 Router T
Parent: Router i
Tally:  |Cam1 -

Finished Delete Selection

Edit Tally Out 1 of Parallel

X

™ Allow user configuiation

MName: |
I~ Invert Qutput
Mapped T allies In Active Tally Channel Out
¥ Program (T
Delete Selection | [ I 1s09
Tally | Logic Channel [" lsn2 [ 1010
GECan 1 ™ lso3 I lso11
™ lso 4 I~ 1012
™ lsoB I~ 15013
[~ IsoB I~ lso14
P s [" 107 I~ lsa15
Repeat Edit Overide
- Cancel
™ AutoInc Faorced On

I Forced Off
O ok

It will be seen that due to the linking within TallyMan, the Cameras will get a Tally (cue) as
well as any UMDs that are driven via the router information.

V1.61 on 27 Tallies



Appendix 1
Tally/GPO control using Omnibus code

Omnibus GPI Mapping Details

I TallyMan - B'cast Asia 2007.tms

File Edit Tools Wew Comms Help
= @ Broadrast Asia 2007 ~
Tally |0 Properties
+ Wirkual Router i ®
= Farallel
w i Tally In Mame: |F'ara||e| Epply
qi',: Tally Cut
+ ; Display Ports Tally Inputs Tally Dutputs
+ - R IMD
+-BF Quartz Panel Hardware: | Omribus In hd Hardware: | Ormnibus Out -
Tallykd an Systern In
s Murnber: Logic Level MNumber: |64
T5L Serial
erial SwP15 | Clear Forced Outputs
AszignEnable | [ [nvert Enable
Set Senial Parameters |
LConfigure [/0 | .
< >
JReady | OFFLINE HUM

Set the required serial port that is used for the Omnibus connection.

Parallel: Setup Communication

ul's
Type: |Seria| RS422 j Cancel
Gereral Parameters Serial Parameters
Part Mumber: |3 Eaud Bate: 38400 -
Drescription: |Elmnibus
Parity: Ewven -
etwark Parameters Data Bits: a -
IP Address: |
Stop Bits: 1 -

Setting the Tally I/0O to "Omnibus" results in the physical inputs (if any) being sent to
Omnibus, and the physical outputs being controllable by Omnibus (OBS).

Omnibus can switch on or off a tally output.

The inputs and outputs continue to behave as normal within Tallyman. The Tally Inputs may
be assigned to objects as normal. The Tally Mimic will show the physical input status. The
Tally Outputs may be mapped as is usual. The link to OBS is effectively overlaid on top of the
normal 1/O.

OBS can “see” the input status, and can control the output status. This is where the "force
on, force off" options are used. OBS can force the state one way or another, overriding any
mapping in TallyMan to that output.
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The mapping procedure is as follows:

e This protocol operates on the existing hardware parallel Tally I/O module - locate this
module (currently set to input type "Logic Level", output type "Open Collector").

e Select "Omnibus In" and "Omnibus Out" as hardware type.

e Configure number of Tally Outputs as required.

e Set the Serial Parameters on the port used to connect to Omnibus.

The parallel tally outs are now controlled by the Omnibus GPI protocol.
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